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Аннотация
Книга является практическим и справочным руководством

и предназначена для самостоятельного изучения и подготовки
к работе в новой версии самой популярной и мощной
универсальной среды проектирования AutoCAD 2009,
разработанной компанией Autodesk. В издании приведены общие
сведения о системе, подробно рассмотрен пользовательский
интерфейс, описываются средства создания, редактирования и
оформления чертежей, принципы трехмерного моделирования,
в том числе получение реалистических изображений, а также
твердых копий чертежа. Книга рекомендована студентам
технических и дизайнерских специальностей. Изложение
сопровождается многочисленными рисунками, примерами,
диалоговыми окнами, что облегчает не только изучение, но и
дальнейшую работу в среде AutoCAD.
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Татьяна Юрьевна Соколова
AutoCAD 2009 для

студента. Самоучитель
 

Введение
 

Постоянно растущий уровень компьютерных технологий,
динамичное развитие программных и аппаратных средств
влекут за собой бурный переход от традиционных методов
ведения проектно-конструкторских работ к использованию
новых автоматизированных систем разработки и выполне-
ния конструкторской документации.

На сегодняшний день производство продукции мирового
класса возможно только на соответствующем оборудовании
и с использованием современных средств автоматизации.
Ни одно предприятие, ведущее разработки сложных тех-
нических объектов, теперь не обходится без использования
компьютеров и мощного программного обеспечения, позво-
ляющего гармонично сочетать форму и содержание проек-
та, оптимизировать процесс разработки и выполнения кон-
структорской документации при многократном использова-
нии имеющихся данных.

Базовые графические системы обогащают, но не услож-



 
 
 

няют возможности творческого поиска конструкторов, по-
скольку обладают высокотехнологичными и удобными, про-
стыми в обращении инструментами, при помощи которых в
одном проекте реализуются замыслы целой команды проек-
тировщиков и требования заказчиков. На базе универсаль-
ных графических систем разрабатываются автоматизирован-
ные рабочие места конструкторов, технологов, архитекто-
ров, схемотехников и многих других разработчиков.

Новейшие компьютерные технологии предоставляют со-
временные аппаратные, программные и информационные
средства, реализующие автоматизацию инженерно-графиче-
ских работ. При этом предполагается обеспечение ввода, вы-
вода, создания, хранения и обработки моделей геометриче-
ских объектов и их изображений с помощью компьютера, а
также наличие средств моделирования геометрических объ-
ектов, их обработки и др.

В последнее время все больше утверждается оригиналь-
ный подход к автоматизации конструкторской деятельно-
сти, в основе которого – создание трехмерных геометриче-
ских представлений графических моделей изделий. Совре-
менный уровень развития компьютерных технологий позво-
ляет создавать пространственные модели объектов с практи-
чески неограниченными возможностями, обеспечивая боль-
шую достоверность решения геометрических и других задач
для пространственной модели, что позволяет перейти на ка-
чественно новый уровень разработки.



 
 
 

В настоящее время существует множество графических
редакторов и программ геометрического моделирования.
Компания Autodesk – один из ведущих производителей си-
стем автоматизированного проектирования и программного
обеспечения для конструкторов, дизайнеров, архитекторов.
Это крупнейший в мире поставщик программного обеспече-
ния и услуг для промышленного и гражданского строитель-
ства, машиностроения, геоинформатики, цифровых средств
передачи информации и беспроводной связи, обслуживаю-
щий 7 000 000 пользователей.

Система AutoCAD, разработанная этой компанией, яв-
ляется лидирующей в мире платформой программного
обеспечения систем автоматизированного проектирования
(САПР), предназначенной для профессионалов, которым
требуется воплощать свои творческие замыслы в реальные
динамические проекты.

AutoCAD – программа с богатой и во многом уникальной
историей. Впервые она увидела свет в 1982 году под име-
нем MicroCAD. Первая версия AutoCAD ознаменовала на-
чало настоящей революции в автоматизированном проекти-
ровании. Сегодня AutoCAD переводится на 18 языков, ее
используют в своей работе миллионы проектировщиков во
всем мире на процессорах в тысячи раз мощнее тех, которые
были установлены на первых персональных компьютерах.

AutoCAD является постоянно развивающейся базовой
средой проектирования, каждая новая версия которой на-



 
 
 

следует все лучшее от предыдущих и направлена на реше-
ние следующих основных задач: повышение производитель-
ности и эффективности работы пользователей; обеспечение
многократного использования имеющихся наработок; бес-
препятственное сотрудничество пользователей при проекти-
ровании; адаптация AutoCAD к индивидуальным потребно-
стям разработчиков объектно-ориентированных задач.

Залог успеха Autodesk – мировое признание AutoCAD
в качестве стандарта дефакто для разработки продуктов
и комплектующих, а также документации. Используя свою
стратегию, направленную на помощь заказчикам в созда-
нии, организации и распространении цифровых конструк-
торских данных и в решении серьезных бизнес-проблем,
Autodesk предлагает наиболее полный комплект интегриро-
ванных программных инструментов двумерного и трехмер-
ного конструирования, что позволяет создавать более каче-
ственные продукты, ускорять вывод изделий на рынок и до-
биваться максимальной наглядности проектов и максималь-
но эффективного сотрудничества.

Благодаря выпуску AutoCAD 2009 компания Autodesk
предлагает архитекторам, дизайнерам, инженерам и проек-
тировщикам новый инструмент для еще более полного во-
площения их идей в реальность.

Тренинг-система
Для удобства читателей и лучшего усвоения

ими приемов работы в программе в данной



 
 
 

книге предлагается авторская тренинг-система. Все
упоминания о ней выделяются так же, как данная
врезка. Архив с приведенными упражнениями
уникальной авторской электронной тренинг-системы
вы можете скачать с сайта издательства «Питер» по
адресу http://www.piter.com/download/978538800372.

http://www.piter.com/download/978538800372


 
 
 

 
От издательства

 
Ваши замечания, предложения и вопросы отправляйте по

адресу электронной почты dgurski@minsk.piter.com  (изда-
тельство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете по-

дробную информацию о наших книгах.

mailto:dgurski@minsk.piter.com
http://www.piter.com/


 
 
 

 
Глава 1

AutoCAD 2009. Общие сведения
 
 

Требования к системе
 

AutoCAD может работать как в автономном режиме, так и
в локальной сети. Для эффективной работы AutoCAD 2009
под управлением операционной системы Windows необходи-
мы следующие программные и аппаратные средства:

• процессор Intel® Pentium® IV;
• операционные системы: Microsoft® Windows® XP

Professional или Home Edition (пакет обновлений SP1 или
SP2), Windows XP Tablet PC Edition (SP2) или Windows 2000
(SP3 или SP4). Рекомендуется устанавливать и эксплуатиро-
вать AutoCAD либо в операционной системе, локализован-
ной на одном языке с программой, либо в англоязычной вер-
сии одной из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1
или более поздний);

• 512 Мбайт оперативной памяти;
• монитор VGA с разрешением не менее 1024 × 768 и под-

держкой режима true color;
• 750 Мбайт свободного места на жестком диске для уста-



 
 
 

новки;
• привод компакт-дисков: любой (только для установки

программы).
Требования к системе при использовании AutoCAD 2009

для концептуального проектирования:
• процессор Intel® с тактовой частотой 3,0 ГГц и выше;
• Windows XP Professional (пакет обновлений SP2);
• не менее 2 Гбайт оперативной памяти;
• 2 Гбайт свободного места на жестком диске, не считая

места, необходимого для установки программы;
• Монитор с минимальным разрешением 1280 × 1024 и

поддержкой режима true color;
• графический адаптер класса рабочих станций, снабжен-

ный не менее 128 Мбайт памяти и поддерживающий техно-
логию OpenGL.



 
 
 

 
Запуск системы AutoCAD

 
Запуск AutoCAD осуществляется следующими способа-

ми:
• на Панели задач выберите из меню Start → Programs →

Autodesk → AutoCAD 2009;
• на Рабочем столе Windows дважды щелкните на пикто-

грамме AutoCAD 2009.
При запуске AutoCAD предлагает создать новый неиме-

нованный рисунок. Можно либо начать создавать в нем объ-
екты, либо загрузить с диска один из уже имеющихся фай-
лов.

При открытии ранее подготовленного имеющегося рисун-
ка всем системным переменным присваиваются значения,
которые они имели в ходе последнего сеанса работы с ним.
Это происходит благодаря тому, что переменные сохраняют-
ся в файле вместе с рисунком.

Если же вы начинаете работу с нуля, следует предвари-
тельно задать ряд установок. Обычно это делается автома-
тически с помощью Мастера подготовки Wizard Description.
AutoCAD позволяет менять установки и в ходе сеанса, если
возникает такая необходимость.



 
 
 

 
Начало работы

 
После запуска AutoCAD выводится диалоговое окно на-

чала работы Startup (рис. 1.1).

Рис. 1.1. Диалоговое окно начала работы

В диалоговом окне Startup пользователю предлагаются че-
тыре кнопки, в зависимости от выбора которых меняется со-
держимое диалогового окна:



 
 
 

Open a Drawing – для открытия ранее созданного чертежа.
Позволяет выбрать из списка один из рисунков, открывав-
шихся последними, и загрузить его в AutoCAD. Чтобы за-
грузить файл, отсутствующий в списке, следует нажать кноп-
ку обзора Browse…;

Start from Scratch – для создания чертежа, где устанавли-
ваются только единицы измерения в области Default Settings:
британские (футы и дюймы) или метрические (миллимет-
ры):

• Imperial (feet and inches) – создание нового рисунка,
использующего британскую систему единиц измерения, по
шаблону acad.dwt. При этом область рисования, называемая
еще лимитами рисунка, устанавливается равной 12 × 9 дюй-
мов;

• Metric – создание нового рисунка, использующе-
го метрическую систему единиц измерения, по шаблону
acadiso.dwt. При этом область рисования устанавливается
равной 429 × 297 мм;



 
 
 

Use a Template – для создания чертежа по шаблону – доку-
менту, установки которого используются как основа для но-
вого рисунка. В области Select a Template: выбирается шаб-
лон, содержащий необходимые установки черчения. В спис-
ке перечисляются имена файлов шаблонов с расширением
DWT, которые найдены по стандартному пути, заданному в
диалоговом окне настроек Options. В шаблонах определяют-
ся различные параметры рисунка, в том числе наборы спе-
циально созданных слоев, типов линий и видов;

Use a Wizard – вызов Мастера для установки параметров
нового чертежа. В области Select a Wizard: предлагается два
режима автоматической настройки рабочей среды AutoCAD
– детальная подготовка Advanced Setup и быстрая подготов-
ка Quick Setup.

• Диалоговое окно детальной подготовки Advanced Setup
позволяет выполнить полную установку параметров рабочей
среды AutoCAD: назначить единицы измерения длины Units



 
 
 

и угла Angle, задать начало отсчета угла Angle Measure и на-
правление его измерения Angle Direction, определить грани-
цы области рисунка Area.

• Диалоговое окно быстрой подготовки Quick Setup поз-
воляет выполнить быструю установку параметров рабочей
среды AutoCAD: выбрать единицы измерения длины Units и
определить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при
каждой загрузке сеанса AutoCAD только один раз. В даль-
нейшем для создания рисунков в уже запущенном сеансе
AutoCAD открывается диалоговое окно создания нового ри-
сунка Create New Drawing.



 
 
 

 
Подробнее о шаблоне

 
Установленный набор параметров сеанса можно сделать

доступным и для рисунков, создаваемых впоследствии. Для
этого следует сохранить документ как шаблон. Шаблон
обычно представляет собой рисунок, не содержащий ника-
ких графических объектов и используемый только для хра-
нения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удоб-
ное средство создания набора рисунков с однотипными на-
стройками. Можно использовать как шаблоны, поставляе-
мые с AutoCAD, так и созданные пользователем. Любой
имеющийся рисунок можно сохранить в качестве шаблона.
В этом случае значения всех параметров настройки сохра-
няемого документа будут наследоваться всеми создаваемы-
ми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше
всего подготовить набор стандартных шаблонов, где пред-
ставлены чаще всего используемые установки и базовые эле-
менты:

• тип и точность представления единиц;
• лимиты рисунка;
• настройки режимов шага SNAP, сетки GRID и ортого-

нального режима ORTHO;
• организация слоев;



 
 
 

• основные надписи, рамки и логотипы;
• размерные и текстовые стили;
• типы и веса (толщины) линий.
Никакие изменения, вносимые в рисунок, созданный на

основе шаблона, на сам шаблон не распространяются.



 
 
 

 
Вызов справочной системы

 

В любой момент работы с AutoCAD вы можете получить
доступ к электронной документации по программе. Для это-
го необходимо выбрать в падающем меню пункт Help. Аль-
тернативный вариант – нажать клавишу F1 на функциональ-
ной клавиатуре, ввести символ ? в  командной строке или
щелкнуть на пиктограмме со значком вопроса на стандарт-
ной панели инструментов.



 
 
 

 
Открытие рисунков

 
Программа AutoCAD по умолчанию записывает внутрен-

нее представление рисунка в файл с расширением DWG.
Кроме рисунка файл содержит ряд параметров, определяю-
щих значения переключателей режимов шага SNAP, сетки
GRID, ортогонального режима ORTHO; принятые единицы
измерения и точность представления; границы рисунка; ор-
ганизацию слоев; форматы и логотипы; размерные и тексто-
вые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирова-
ния Multiple Design Environment (MDE), которая допускает
одновременное открытие нескольких чертежей. В одном се-
ансе работы можно открывать неограниченное количество
рисунков, не жертвуя при этом производительностью. Среда
MDE позволяет перетаскивать объекты, копировать их свой-
ства, такие как цвет, слой, тип линии, из одного рисунка в
другой. Она обеспечивает параллельную работу с нескольки-
ми рисунками, не прерывая выполнения текущей команды и
не нарушая последовательности действий. Это существенно
упрощает выполнение многих операций и повышает эффек-
тивность работы.



 
 
 

Открыть существующий рисунок можно с помощью ко-
манды OPEN, которая вызывается из падающего меню File
→ Open… или щелчком на пиктограмме Open… (CTRL+O)
на стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD
появляется диалоговое окно выбора файла Select File (рис.
1.2). Здесь можно выбрать имя файла из списка или ввести
это название в поле File name:.

Рис. 1.2. Диалоговое окно выбора файла

При выделении в списке одного из файлов в области
Preview появляется соответствующий образец рисунка. На-



 
 
 

жатие кнопки Views выводит список, изменяя параметры ко-
торого пользователь может выбрать форму представления
файлов, предлагаемых для открытия: список, таблицу, об-
разцы.

Режим открытия файлов – Open (открыть), Open Read-
Only (открыть для чтения), Partial Open (открыть частич-
но), Partial Open Read-Only (открыть для чтения частич-
но) – устанавливается в списке при нажатии стрелки спра-
ва от кнопки Open. Частичное открытие позволяет загру-
жать только те объекты рисунка, которые принадлежат опре-
деленным слоям или видовым экранам. Это оказывается по-
лезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следу-
ет выбрать необходимые файлы в диалоговом окне Select
File, используя клавишу Shift или Ctrl.

Кроме того, рисунки можно открывать путем перетаски-
вания из Проводника Windows. Для этого один или несколь-
ко выделенных в дереве Проводника файлов следует перета-
щить с помощью мыши в любую часть окна AutoCAD, за ис-
ключением области рисунка, например, на командную стро-
ку или в ту часть панелей инструментов, которая не занята
кнопками. Если же перетащить один файл в область рисова-
ния уже открытого рисунка, то произойдет вставка содержи-
мого перетаскиваемого документа в текущий рисунок в ка-
честве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени



 
 
 

соответствующего файла в Проводнике Windows, что приве-
дет к автоматическому запуску AutoCAD. Если же в системе
уже ведется сеанс работы в AutoCAD, то рисунок откроется
в нем.

В AutoCAD имеется специальное средство просмотра
небольших фрагментов рисунков, открытия файлов рисун-
ков и их поиска. Его можно использовать для поиска файлов
в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска фай-
лов Find, показанного на рис. 1.3, необходимо в диалоговом
окне Select File последовательно щелкнуть на кнопках Tools
→ Find….



 
 
 

Рис. 1.3. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find ука-
зываются имя, расширение и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам
их создания, пользуясь вкладкой Date Modified диалогового
окна Find (рис. 1.4). Здесь организуется поиск файлов, со-
зданных или измененных в период между двумя указанны-
ми датами либо за определенное количество последних дней
или месяцев. Имена найденных документов отображаются в



 
 
 

нижней части диалогового окна.

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей
версии, открываются как любой документ версии 2009 и ав-
томатически преобразуются в новый формат.



 
 
 

 
Создание рисунков

 
При создании рисунка могут использоваться различные

стандарты. Иногда они диктуются государственными и от-
раслевыми стандартами или нормами предприятия, иногда
– требованиями заказчика. Ключевой момент как для непо-
средственных исполнителей, так и для руководителей групп,
контролирующих ход выполнения проекта, – грамотная под-
готовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект.
Он может включать в себя множество разделов: планы эта-
жей, схемы сетей водоснабжения, канализации, отопления,
вентиляции и т. п. Обычно каждый раздел проекта разраба-
тывается в отдельном подразделении, поэтому здесь остро
встает проблема унификации. Наиболее грамотное ее реше-
ние – обеспечение всех исполнителей файлами шаблонов,
настроенными на используемую систему единиц и содержа-
щими стандартные рамку, основную надпись, слои и типы
линий.

Не менее важно, какие стили используются для текстовых
надписей, штрихования и нанесения размеров. Их также сле-
дует задавать заранее: это дает гарантию, что каждый проек-
тировщик будет действовать без отклонения от оговоренных
стандартов.

Следует ответственно подходить к выбору рабочего мас-



 
 
 

штаба. Только четкое представление о том, как соотносятся
единицы рисунка на экране и единицы чертежа, выводимого
на плоттер, позволяет правильно выбрать высоту текста для
пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на по-
следних стадиях проектирования, грамотное планирование
на предварительных этапах позволяет избежать многих оши-
бок и избавить персонал от излишних операций редактиро-
вания. При создании проекта работа, как правило, ведется в
пространстве модели (здесь объекты представляются в нату-
ральную величину), а для компоновки чертежа выполняется
переход в пространство листа, где ко всем графическим объ-
ектам, текстам, типам линий и размерам применяется необ-
ходимый масштабный коэффициент.

Все начальные установки рисунка могут быть сохранены
в шаблоне для последующего использования в других доку-
ментах. В качестве шаблона могут применяться как рисунки,
поставляемые с AutoCAD, так и любые другие, в том чис-
ле созданные пользователем. Новый рисунок наследует всю
информацию из используемого шаблона. Имеется также воз-
можность запускать AutoCAD без шаблона.

Создать новый рисунок позволяет команда NEW, вызы-
ваемая из падающего меню File → New… или щелчком на



 
 
 

пиктограмме QNew на стандартной панели инструментов.
После запуска команды необходимые настройки парамет-

ров рабочей среды AutoCAD производятся в диалоговом ок-
не создания нового рисунка Create New Drawing – рис. 1.5.

Рис. 1.5. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону исполь-
зуется пиктограмма Start from Scratch. В данном режиме
устанавливается британская или метрическая система еди-
ниц. Значения многих системных переменных, принятые по
умолчанию, зависят от того, какая из двух систем выбрана.



 
 
 

Эти переменные управляют текстом, размерами, сеткой, ре-
жимами привязки, а также устанавливают действующие по
умолчанию тип линий и файл образцов штриховки:

• Imperial (feet and inches) – создается рисунок, использу-
ющий британскую систему единиц измерения (футы и дюй-
мы), по шаблону acad.dwt. При этом область рисования, ина-
че называемая лимитами рисунка, устанавливается равной
12 × 9 дюймов;

• Metric – создается рисунок, где используется метриче-
ская система единиц измерения, по шаблону acadiso.dwt.
При этом устанавливается область рисования 429 × 297 мм.

Чтобы создать рисунок с использованием шаблона, необ-
ходимо в диалоговом окне Create New Drawing щелкнуть на
пиктограмме Use a Template и в списке Select a Template:
указать нужный шаблон (рис. 1.6).



 
 
 

Рис. 1.6. Выбор шаблона рисунка

В AutoCAD имеется так называемый Мастер подготовки
Wizard – служебное средство для создания нового рисунка.
С помощью Мастера подготовки можно, взяв за основу теку-
щий шаблон, модифицировать некоторые базовые установ-
ки. Например, пользователь может автоматически настраи-
вать масштабные коэффициенты для текста в зависимости
от общих размеров рисунка. Если рисунки крупные, выбира-
ется большая высота символов, если мелкие – меньшая; та-
ким образом обеспечивается разборчивость текстовых над-



 
 
 

писей, когда рисунок отображается на экране целиком.
Для вызова Мастера подготовки необходимо в диалого-

вом окне Create New Drawing щелкнуть на пиктограмме Use
a Wizard – откроется окно, показанное на рис. 1.7.

Рис. 1.7. Создание нового рисунка с помощью Мастера
подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.8) позво-
ляет задать для нового рисунка единицы измерения Units
и область рисования Area. Поддерживаются следующие ти-
пы единиц для рисования и вычерчивания: десятичные
– Decimal, инженерные – Engineering, архитектурные –



 
 
 

Architectural, дробные – Fractional, научные – Scientific.

Рис. 1.8. Диалоговое окно Мастера быстрой подготовки

Указывая ширину Width и длину Length области рисова-
ния, пользователь тем самым задает граничные пределы ри-
сунка, так называемые лимиты. Именно лимитами опреде-
ляется размер чертежа, впоследствии выводимого на плот-
тер. После того как все параметры заданы, Мастер быстрой
подготовки запускает сеанс рисования в пространстве моде-
ли.

Мастер детальной подготовки Advanced Setup (рис. 1.9)
позволяет задать для нового рисунка тип линейных единиц
измерения Units и способ измерения углов Angle, указать на-
чало отсчета угла Angle Measure и направление измерения



 
 
 

угла Angle Direction, определить границы области рисунка
Area. В отличие от Мастера быстрой подготовки, который
настраивает только пространство модели, Мастер детальной
подготовки воздействует как на пространство модели, так и
на пространство листа.

Рис. 1.9. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования,
в дальнейшем может быть изменена.



 
 
 

 
Определение границ рисунка

 
Команда LIMITS позволяет установить границы теку-

щего рисунка в пространстве модели и в пространстве ли-
ста. Она вызывается из падающего меню Format → Drawing
Limits. В AutoCAD границы рисунка выполняют две функ-
ции: определяют диапазон изменения координат точек и
контролируют фрагмент рисунка, покрытый видимой коор-
динатной сеткой.

Границы рисунка – это пара двумерных точек в мировой
системе координат: координаты левого нижнего и правого
верхнего углов, определяющие прямоугольную область. По
оси Z границы не устанавливаются.

Запросы команды LIMITS:
Reset Model space limits:  – переустановка лимитов

пространства модели
Specify lower left corner or [ON/OFF] <current>:  –

левый нижний угол
Specify upper right corner <current>:  – правый

верхний угол где:

• ON – включается контроль соблюдения границ. При
этом AutoCAD отвергает все попытки ввести точки с коор-
динатами, выходящими за границы рисунка;

• OFF – отключается контроль соблюдения границ рисун-
ка;



 
 
 

• <current> – текущее значение.
Если текущее значение границ рисунка вас устраивает,

достаточно нажать клавишу Enter.
Лимиты должны полностью охватывать полномасштаб-

ную модель. Например, если ее размеры 100 × 200 мм, зна-
чения лимитов должны слегка превышать эти цифры.

В пространстве листа лимиты обычно задают равными
формату листа бумаги. Следовательно, сетка (если она вклю-
чена) покрывает при этом весь скомпонованный чертеж,
включая графические объекты, размерные элементы, основ-
ную надпись и т. п. Например, если формат листа равен 210
× 297 мм, следует установить десятичный формат единиц и
определить лимиты указанием точек 0,0 для левого нижнего
угла прямоугольника и 210,297 – для правого верхнего угла.

Если в пространстве листа отображаются поля листа или
подложен заданный формат, нельзя задать границы рисун-
ка с помощью команды LIMITS. В этом случае лимиты вы-
числяются и устанавливаются в зависимости от размеров вы-
бранного листа. Включение и отключение отображения по-
лей и разметки листа производится на вкладке Display диа-
логового окна Options.

В пространстве модели лимиты могут быть заданы при со-
здании нового рисунка с помощью Мастера быстрой подго-
товки или Мастера детальной подготовки.

Тренинг-система
Выполните упражнение N4 из раздела 1.



 
 
 



 
 
 

 
Определение параметров сетки

 
Сеткой называется упорядоченная последовательность

точек, покрывающих область рисунка в пределах лимитов.
Работа в режиме GRID подобна наложению на рисунок ли-
ста бумаги в клетку. Использование сетки помогает вырав-
нивать объекты и оценивать расстояние между ними. Сетку
можно включать и отключать в ходе выполнения других ко-
манд. На печать она не выводится.

Включение сетки и определение ее частоты осуществля-
ется на вкладке Snap and Grid диалогового окна режимов ри-
сования Drafting Settings (рис. 1.10), которое загружается из
падающего меню Tools → Drafting Settings… или при выборе
пункта настройки Settings… контекстного меню, вызываемо-
го щелчком правой кнопкой мыши на кнопке Grid Display в
строке состояния.



 
 
 

Рис. 1.10. Диалоговое окно определения параметров сет-
ки и шага привязки

Сетка включается при установке флажка Grid On (F7). В
области Grid spacing устанавливается частота горизонталь-
ных и вертикальных делений сетки, то есть шаг сетки по
осям X и Y. Это осуществляется в текстовых полях Grid X



 
 
 

spacing: и Grid Y spacing: соответственно. В поле Major line
every: устанавливается шаг основной линии.

В области Grid behavior определяется режим сетки:
Adaptive grid – настройка сетки, Allow subdivision below grid
spaсing – разрешение дробления мельче шага сетки, Display
grid beyond Limits – показать сетку за лимитами, Follow
Dynamic UCS – следовать динамической ПСК.

При работе с рисунком включать и отключать сетку сле-
дует щелчком на кнопке Grid Display в строке состояния или
нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с
новым коэффициентом экранного увеличения может потре-
боваться изменение частоты сетки.

Тренинг-система
Выполните упражнение N5 из раздела 1.



 
 
 



 
 
 

 
Определение шага привязки

 
В режиме шаговой привязки SNAP курсор может нахо-

диться только в определенных точках согласно установлен-
ному значению шага и при этом движется не плавно, а скач-
кообразно между узлами воображаемой сетки, как бы «при-
липая» к  ее узлам. Активность режима шаговой привяз-
ки SNAP можно определить визуально, по скачкообразному
движению курсора на экране. Шаговая привязка обычно ис-
пользуется для точного указания точек с помощью мыши.
Интервал привязки задается отдельно по осям X и Y. Вклю-
чение и отключение режима шаговой привязки может про-
изводиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сет-
ки. Сетку часто делают достаточно редкой, используя ее ис-
ключительно для наглядности, а шаг привязки устанавлива-
ют меньшим. Допустимо и обратное: установка большего по
сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее пара-
метров осуществляются на вкладке Snap and Grid диалого-
вого окна режимов рисования Drafting Settings, которое за-
гружается из падающего меню Tools → Drafting Settings…
или при выборе пункта Settings… из контекстного меню, вы-
зываемого щелчком правой кнопкой мыши на кнопке Snap
Mode в строке состояния (см. рис. 1.10).



 
 
 

Шаговая привязка включается при установке флажка
Snap On (F9). В области Snap spacing задается шаг привязки
по горизонтали и вертикали. Это осуществляется в тексто-
вых полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается рав-
ный шаг по осям X и Y. В области Polar spacing задается шаг
полярной привязки.

Тип привязки устанавливается в области Snap type. Grid
snap – шаговая привязка (Rectangular snap – ортогональная,
Isometric snap – изометрическая), PolarSnap – полярная при-
вязка.

При работе с рисунком включать и отключать шаговую
привязку следует щелчком на кнопке Snap Mode в строке со-
стояния или нажатием функциональной клавиши F9.

Тренинг-система
Выполните упражнения N6 из раздела 1 и L4 из

раздела 2.



 
 
 



 
 
 



 
 
 

 
Сохранение рисунков

 

Команда сохранения рисунка QSAVE вызывается из па-
дающего меню File → Save или щелчком на пиктограмме
Save CTRL+S на стандартной панели инструментов. Коман-
да QSAVE используется в тех случаях, когда уже существу-
ющий рисунок сохраняется без изменения его имени. Если
рисунок новый и его имя не определено, то QSAVE действу-
ет так же, как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохране-
ния рисунка под другим именем. Команда SAVE может вы-
зываться только из командной строки, а SAVEAS – из падаю-
щего меню File → Save As…. В обоих случаях имя докумен-
та задается в поле File name: диалогового окна Save Drawing
As – рис. 1.11.



 
 
 

Рис. 1.11. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается рас-
ширение BAK вместо DWG. Все предыдущие BAK-файлы
с данным именем удаляются. Обновленный рисунок запи-
сывается с расширением DWG. Если при указании имени
файла оказывается, что рисунок с таким названием уже су-
ществует, выдается предупреждение и предоставляется воз-
можность перезаписать файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в
раскрывающемся списке Files of type: диалогового окна Save
Drawing As необходимо выбрать пункт AutoCAD Drawing



 
 
 

Template (*.dwt).
Чтобы обеспечить автоматическое сохранение рисунка

через заданные интервалы времени, следует использовать
вкладку Open and Save диалогового окна Options. Оно вызы-
вается из падающего меню Tools → Options…. Необходимо
установить флажок автосохранения Automatic save в обла-
сти File Safety Precautions и установить значение интервала
в минутах между автосохранениями в поле Minutes between
saves.



 
 
 

 
Получение твердой копии рисунка

 
Распечатка чертежа – последний этап при работе с рисун-

ком. Перед выводом рисунка на печать необходимо его ском-
поновать, то есть определить, какие виды должны быть вы-
черчены. Работа над рисунком ведется на разных этапах ли-
бо в пространстве модели, либо в пространстве листа. Про-
странство модели предназначено для создания модели –
изображения в реальном масштабе. Пространство листа
представляет собой аналог листа бумаги, на котором произ-
водится создание и размещение видов перед вычерчивани-
ем.

Как в пространстве модели, так и в пространстве листа
может быть один или несколько видовых экранов, на кото-
рых представлены различные виды модели. Компоновка чер-
тежа, по сути дела, представляет собой процесс создания и
размещения таких экранов. По завершении компоновки чер-
теж выводится на принтер или плоттер.

Перед выводом рисунка на плоттер можно предваритель-
но просмотреть, как он будет размещаться на листе бума-
ги. Для этого используется команда предварительного про-
смотра PREVIEW, вызываемая из падающего меню File →



 
 
 

Plot Preview или щелчком на пиктограмме Plot Preview на
стандартной панели инструментов. При этом автоматически
включается изменение масштаба изображения в режиме ре-
ального времени для просмотра мелких деталей чертежа.

Все установки вывода рисунка на плоттер осуществляют-
ся в диалоговом окне Plot – Model (рис. 1.12). Это окно за-
гружается командой PLOT, вызываемой из падающего меню
File → Plot…, или щелчком на пиктограмме Plot… (CTRL
+P) на стандартной панели инструментов.

Рис. 1.12. Диалоговое окно вывода на печать простран-
ства модели



 
 
 

В диалоговом окне Plot – Model делаются следующие на-
значения.

• В области Page setup устанавливается набор параметров
листа. Кнопкой Add… открывается диалоговое окно добав-
ления набора параметров листа.

• В области Printer/plotter устанавливаются параметры:
· из списка Name: выбирается устройство вывода;
· кнопка Properties… загружает редактор параметров

плоттера;
· установкой флажка Plot to file назначается печать в файл.
• В области Paper size определяется формат.
• В области Number of copies устанавливается количество

экземпляров.
• В области Plot area устанавливается печатаемая область:
· Display – экран;
· Limits – лимиты;
· Window – область, выбранная рамкой.
• В области Plot offset (origin set to printable area) опреде-

ляется смещение печатаемой области по осям X и Y, а также
центрированность.

• В области Plot scale определяется масштаб печати и веса
линий:

· Fit to paper – вписать;
· Scale: – масштаб;
· Scale lineweights – масштабировать веса линий.
• В области Plot style table (pen assignments) определяется



 
 
 

таблица стилей печати.
• В области видовых экранов с раскрашиванием Shaded

viewport options определяется:
· Shade plot – способ вывода (как на экране, каркас, скры-

тие линий; 3D-скрытый, 3D-каркас, концептуальный, реали-
стичный; тонирование, черновое, низкое, среднее, высокое,
презентационное);

· Quality – качество (черновое, просмотр, нормальное,
презентационное, максимум, пользовательское).

• В области Plot options определяются параметры печати:
· Plot in background – печатать в фоновом режиме;
· Plot object lineweights – учитывать веса линий;
· Plot with plot styles – учитывать стили печати;
· Plot paperspace last – объекты листа последними;
· Hide paperspace objects – скрывать объекты листа;
· Plot stamp on – включить штемпель;
· Save changes to layout – сохранить параметры.
• В области Drawing orientation определяется ориентация

чертежа:
· Portrait – книжная;
· Landscape – альбомная;
· Plot upside-down – перевернутая.
• Кнопка Preview… загружает окно предварительного

просмотра.



 
 
 

 
Выход из AutoCAD

 
Для выхода из AutoCAD используется команда QUIT, ко-

торая вызывается из падающего меню File → Exit (CTRL+Q).
Команда позволяет сохранить или проигнорировать сде-

ланные в рисунке изменения и выйти из AutoCAD. Если
все выполненные изменения сохранены, при выходе из про-
граммы не появится никаких дополнительных сообщений. В
противном случае на экран будет выведено диалоговое ок-
но AutoCAD, предлагающее пользователю выбор: сохранить
изменения, отказаться от них или продолжить сеанс работы.
Если текущему рисунку не было присвоено имя и вы хотите
его сохранить, откроется диалоговое окно Save Drawing As.



 
 
 

 
Глава 2

Пользовательский
интерфейс AutoCAD

 
На рис. 2.1 показан классический рабочий стол AutoCAD

для Windows.

Рис. 2.1. Рабочий стол AutoCAD

В данный рабочий стол включены:



 
 
 

• падающее меню Menu Browser – меню, появляющееся
при щелчке кнопкой мыши на кнопке A в верхнем левом
углу окна программы (рис. 2.2);

• необязательные панели инструментов:
· стандартная панель Standard и панель стилей Styles –

верхняя строка окна программы;
· панель рабочих пространств Workspaces, слоев Layers и

свойств Properties – вторая строка;
· панель рисования Draw и редактирования Modify –

столбцы слева и справа;
· инструментальная палитра Tool Palettes – в правой части

окна программы;
• строка состояния – строка внизу окна программы;
• окно командных строк – выше строки состояния;
• графическое поле , занимающее остальную часть рабоче-

го стола.



 
 
 

Рис. 2.2. Падающее меню



 
 
 

 
Падающие меню

 
Строка падающих меню может быть изменена путем до-

бавления либо удаления тех или иных пунктов. Для это-
го необходимо выбрать в падающем меню пункты Tools
→ Customize → Interface…, в появившемся диалоговом
окне настройки интерфейса пользователя Customize User
Interface на вкладке Customize в области Customizatios in All
CUI Files раскрыть пункт Menus (рис. 2.3). Далее установить
указатель мыши на один из пунктов меню и, щелкнув пра-
вой кнопкой мыши, вызвать контекстное меню, в котором
выбрать соответствующий пункт для удаления имеющихся
или создания новых падающих меню.



 
 
 

Рис. 2.3. Диалоговое окно адаптации меню

Строка падающих меню по умолчанию содержит следую-
щие пункты:

• File – команды работы с файлами: создание, открытие,
сохранение, публикация в Интернете, печать, экспорт фай-



 
 
 

лов в другие форматы, а также диспетчеры параметров ли-
стов, плоттеров, стилей печати и пр.;

• Edit – инструменты для редактирования частей графи-
ческого поля рабочего стола программы, работы с буфером
обмена и пр.;

• View – управление экраном, зумирование, панорамиро-
вание, установка трехмерной точки зрения, создание видо-
вых экранов и именованных видов, установка визуальных
стилей, тонирование, анимация траектории перемещения,
установка необходимых панелей инструментов;

• Insert – команды вставки блоков, внешних объектов,
объектов других приложений;

• Format – команды работы со слоями и их инструмента-
ми; цветом, типами линий; управление стилями текста, раз-
меров, мультилиний, таблиц; видом маркера точки, установ-
ки единиц измерения, границ чертежа;

• Tools – управление рабочими пространствами; палит-
рами; установка порядка прорисовки объектов и получение
сведений о них; работа с блоками и их атрибутами; рабо-
та с языком AutoLISP; работа с пользовательской системой
координат; настройка стандартов оформления; управление
Мастерами (публикации в Интернете, установки плоттеров,
создания таблиц стилей печати, цветозависимых стилей пе-
чати, компоновки листа, создания подшивки, импорта пара-
метров печати); установка параметров черчения и привязок
с помощью диалоговых окон и пр.;



 
 
 

• Draw – команды двумерного и трехмерного рисования;
• Dimension – команды простановки размеров и управле-

ния параметрами размерных стилей;
• Modify – команды редактирования элементов чертежа;
• Window – многооконный режим работы с чертежами;
• Help – вывод на экран системы гипертекстовых подска-

зок.



 
 
 

 
Панели инструментов

 
Команды AutoCAD на панелях инструментов представле-

ны в виде пиктограмм. Если задержать указатель мыши на
пиктограмме, рядом с ней появляется название соответству-
ющей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен ма-
ленький черный треугольник, это значит, что она содержит
подменю с набором родственных команд. Для вызова подме-
ню необходимо на некоторое время задержать на пиктограм-
ме указатель мыши, нажав ее левую кнопку.

Панели инструментов могут быть плавающими (float) или
закрепленными (dock), с фиксированным местоположени-
ем. Допускаются изменения размеров плавающих панелей,
а также их перемещение по графическому полю (рис. 2.4).
Плавающую панель можно сделать закрепленной, перетащив
ее с помощью мыши за пределы графического поля. И на-
оборот, как только закрепленная панель попадает в область
графического поля, она превращается в плавающую.

Рис. 2.4. Плавающая панель инструментов

При необходимости требуемую панель инструментов
можно вывести на рабочий стол, щелкнув левой кнопкой



 
 
 

мыши на ее имени в списке контекстного меню. Для полу-
чения этого контекстного меню необходимо щелкнуть пра-
вой кнопкой мыши, установив ее указатель на любую пикто-
грамму панелей инструментов (рис. 2.5).



 
 
 



 
 
 

Рис. 2.5. Список панелей инструментов

Для удаления панели инструментов необходимо сделать
ее плавающей, если она закреплена, и щелкнуть на кнопке
закрытия, расположенной в правом верхнем углу заголовка
панели.

Если набор необходимых панелей и окон упорядочен на
рабочем столе, во избежание их случайного перемещения
или удаления пользователь может зафиксировать их положе-
ние. Для этого следует вызвать контекстное меню щелчком
правой кнопки мыши на инструменте, изображающем замо-
чек, в правом углу строки состояния и зафиксировать поло-
жение панелей:

• Floating Toolbars/Panels – плавающие панели инструмен-
тов;

• Docked Toolbars/Panels – закрепленные панели инстру-
ментов;

• Floating Windows – плавающие окна;
• Docked Windows – закрепленные окна;
• All – все инструменты: Locked – заблокированы,

Unlocked – разблокированы;
• Help – справка.
Чтобы временно разблокировать панели инструментов,



 
 
 

необходимо удерживать нажатой клавишу Ctrl.
Тренинг-система
Выполните упражнения N2 и N3 из раздела 1.



 
 
 

 
Стандартная панель инструментов

 
Стандартная панель Standard показана на рис. 2.6.

Рис. 2.6. Стандартная панель инструментов

Она содержит следующие инструменты:

QNew – создание нового файла рисунка;

Open… (Ctrl+О) – загрузка существующего файла;

Save (Ctrl+S) – сохранение текущего файла;

Plot… (Ctrl+P) – вывод рисунка на плоттер, принтер или
в файл;



 
 
 

Plot Preview – предварительный просмотр чертежа перед
выводом на печать, позволяющий увидеть размещение чер-
тежа на листе бумаги;

Publish… – публикация листов чертежа в формате фай-
ла Design Web Format (DWF), загрузка диалогового окна
Publish;

3DDWF – экспорт трехмерной модели в формате файла
Design Web Format (DWF);

Cut (Ctrl+X) – копирование объектов в буфер обмена с
удалением их из рисунка;



 
 
 

Copy (Ctrl+C) – копирование выбранных элементов чер-
тежа в буфер Windows без удаления их из исходного доку-
мента;

Paste (Ctrl+V) – вставка данных из буфера Windows;

Match Properties – копирование свойств заданного объек-
та другому объекту;

Block Editor – редактирование блоков;

Undo (Ctrl+Z) – отмена последнего действия;

Redo (Ctrl+Y) – восстановление только что отмененного
действия;



 
 
 

Pan Realtime – перемещение изображения на текущем ви-
довом экране в режиме реального времени;

Zoom Realtime – увеличение или уменьшение видимого
размера объектов на текущем видовом экране в режиме ре-
ального времени;

подменю Zoom – раскрывающийся набор инструментов,
в котором можно задать различные способы увеличения и
уменьшения видимого размера объектов на текущем видо-
вом экране;

Zoom Previous – возврат к показу предыдущего вида;



 
 
 

Properties (Ctrl+1) – загрузка палитры управления свой-
ствами объектов;

DesignCenter (Ctrl+2) – диалоговый интерфейс, позволя-
ющий быстро находить, просматривать, вызывать, перено-
сить в текущий рисунок ранее созданные рисунки, управлять
вхождениями блоков, внешними ссылками и другими эле-
ментами рисунков, такими как слои, листы и текстовые сти-
ли;

Tool Palettes Window (Ctrl+3) – инструментальные палит-
ры в виде отдельных вкладок специального окна, которые
служат эффективным средством хранения/вставки блоков и
штриховки. Палитры могут содержать инструменты, предо-
ставленные сторонними разработчиками;

Sheet Set Manager (Ctrl+4) – диспетчер подшивок наборов
листов, позволяющий организовать размещение пакетов ли-
стов в зависимости от типа чертежей и с возможностью эф-
фективного создания, управления и совместного использо-



 
 
 

вания наборов логически связанных рисунков;

Markup Set Manager (Ctrl+7) – диспетчер наборов поме-
ток, позволяющий организовать работу с рисунками форма-
та DWF;

QuickCalc (Ctrl+8) – калькулятор;

Help – вызов справочной системы.



 
 
 

 
Панель стилей

 
Панель стилей Styles, показанная на рис. 2.7, предназна-

чена для создания новых текстовых, размерных и табличных
стилей.

Рис. 2.7. Панель стилей

Панель содержит следующие инструменты:

Text Style… – создание новых и редактирование имею-
щихся текстовых стилей;

Dimension Style… – создание новых и редактирование
имеющихся размерных стилей;

Table Style… – создание новых и редактирование имею-



 
 
 

щихся табличных стилей;

Multileader Style… – создание новых и редактирование
имеющихся стилей линий-выносок.



 
 
 

 
Панель рабочих пространств

 
Панель Workspaces, показанная на рис. 2.8, позволяет за-

давать параметры рабочих пространств.

Рис. 2.8. Панель рабочих пространств

Рабочие пространства включают только необходимые на-
боры меню, инструментальные панели и палитры, сгруппи-
рованные и упорядоченные соответственно решаемой за-
даче. Элементы интерфейса, не являющиеся необходимы-
ми для решения текущей задачи, скрываются, максимально
освобождая область экрана, доступную для работы.

В AutoCAD определены следующие рабочие простран-
ства:

• 2D Drafting & Annotation – двумерное моделирование



 
 
 

(рис. 2.9);
• 3D Modeling – трехмерное моделирование (рис. 2.10);
• AutoCAD Classic – классический AutoCAD (см. рис.

2.1).

Рис. 2.9. Рабочее пространство для двумерного модели-
рования

Помимо возможности установить рабочее пространство,
в панель Workspaces включены следующие пункты:



 
 
 

• Save Current As… – открытие диалогового окна Save
Workspace, позволяющего сохранить текущее рабочее про-
странство;

• Workspace settings… – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-
метры рабочего пространства для последующего использо-
вания;

Рис. 2.10. Рабочее пространство для трехмерного моде-
лирования

• Customize… – открытие диалогового окна Customize
User Interface, позволяющего осуществить настройки интер-



 
 
 

фейса пользователя.
А также панель Workspaces содержит следующие инстру-

менты:

Workspace Settings… – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-
метры рабочего пространства для последующего использо-
вания;

My Workspace – возвращение имени текущего рабочего
пространства в интерфейс командной строки и установление
этого пространства текущим.

Рабочее пространство 3D Modeling включает новый пульт
управления, обеспечивающий удобный доступ к новым
функциям трехмерного моделирования. В области рисова-
ния отображается цвет фона, наземная плоскость или рабо-
чая поверхность и новая прямоугольная сетка, что улучшает
трехмерную визуализацию и облегчает создание простран-
ственных моделей. Новый трехмерный курсор обеспечива-
ет указание направления ПСК. Вкладки Model и Lauout за-
менены кнопками в строке состояния, благодаря чему рас-
ширена область рисования. На режим отображения вкладок
можно переключиться, щелкнув правой кнопкой мыши на



 
 
 

кнопке Model или Lauout.
Тренинг-система
Выполните упражнение N1 из раздела 1.



 
 
 

 
Панель слоев

 
Панель слоев Layers, показанная на рис. 2.11, обеспечи-

вает работу со слоями.

Рис. 2.11. Панель слоев

В нее входят следующие инструменты:

Layer Properties Manager – вызов Диспетчера свойств сло-
ев Layer Properties Manager;

Layer Control – раскрывающийся список управления слоя-
ми. Каждая строка содержит пиктограммы управления свой-
ствами слоя или отображения его свойств, а также его имя.
Ниже перечисляются эти пиктограммы (слева направо):

• Turn a layer On or Off – включение/отключение слоя;
• Freeze or thaw in ALL viewports – замораживание/размо-

раживание на всех видовых экранах;
• Freeze or thaw in current viewport – замораживание/раз-

мораживание на текущем видовом экране;



 
 
 

• Lock or Unlock a layer – блокирование/разблокирование
слоя;

• Color of layer – цвет слоя;
• Layer Control – имя слоя.

Make Object's Layer Current – установка текущего слоя в
соответствии со слоем выбранного примитива;

Layer Previous – возврат к предыдущему состоянию слоев;

Layer States Manager – загрузка диалогового окна Layer
States Manager.



 
 
 

 
Панель свойств объектов

 
Панель свойств объектов Properties, показанная на рис.

2.12, предназначена для работы с цветом, типом и весом ли-
ний.

Рис. 2.12. Панель свойств объектов

В нее входят следующие инструменты:

Color Control – раскрывающийся список установки теку-
щего цвета, а также изменения цвета выбранных объектов;

Line Type Control – раскрывающийся список установки
текущего типа линии, а также изменения типа линии для вы-
бранных объектов;

Line Weight Control – раскрывающийся список установки



 
 
 

текущего веса (толщины) линии, а также изменения толщи-
ны линий выбранных объектов;

Plot Styles Control – раскрывающийся список установки
стилей печати. Здесь можно изменять внешний вид вычер-
чиваемого на плоттере рисунка. В стилях печати при необ-
ходимости переопределяются цвета, типы и веса (толщины)
линий объектов. Кроме этого, имеется возможность указы-
вать используемые при печати стили концов линий, соеди-
нений и заполнений, а также различные выходные эффекты
– размывание, оттенки серого, присвоения перьев и интен-
сивность. Манипулируя стилями печати, можно получить на
бумаге различные варианты одного и того же рисунка. До-
пускается применение стилей печати к объектам или слоям.



 
 
 

 
Строка состояния

 
Строка состояния (рис. 2.13) расположена в нижней части

рабочего стола.

Рис. 2.13. Строка состояния

Она содержит текущие координаты курсора, а также кноп-
ки включения/выключения режимов черчения:

Snap Mode – включение и выключение шаговой привязки
курсора;

Grid Display – включение и выключение отображения сет-
ки;

Ortho Mode – включение и выключение ортогонального
режима;



 
 
 

Polar Tracking – включение и выключение режима поляр-
ного отслеживания;

Object Snap – включение и выключение режимов объект-
ной привязки;

Object Snap Tracking – включение и выключение режима
отслеживания при объектной привязке;

Allow/Disallow Dynamic UCS – включение и выключение
динамической пользовательской системы координат;

Dynamic Input – включение и выключение динамического
ввода;



 
 
 

Show/Hide Lineweight – включение и выключение режима
отображения линий в соответствии с весами (толщинами);

Quick Properties – включение и выключение свойств объ-
ектов;

Model or Paper space – переключение из пространства мо-
дели в пространство листа;

Quick View Layouts – включение и выключение просмотра
листов;

Quick View Drawings – включение и выключение просмот-
ра рисунков;



 
 
 

Pan – панорамирование рисунка;

Zoom – зумирование рисунка;

SteeringWheel – включение инструмента Wheel;

ShowMotion – включение инструмента Motion.

Отображение кнопок включения/выключения режимов
черчения в строке состояния устанавливается в контекстном
меню (рис. 2.14). Для этого необходимо щелкнуть левой или
правой кнопкой на инструменте Application Status Bar Menu
с изображением стрелки вниз, который находится в правом
углу строки состояния.



 
 
 

Рис. 2.14. Контекстное меню настройки строки состояния

Опция Tray Settings… открывает диалоговое окно Tray
Settings (рис. 2.15), позволяющее произвести настройку об-
ласти уведомлений.



 
 
 

• Display icons from services – показывать значки служб.
• Display notifications from services – показывать уведом-

ления от служб:
· Display time – время отображения;
· Display until closed – до явного закрытия.

Рис. 2.15. Диалоговое окно настройки области уведомле-
ний



 
 
 

 
Окно командных строк

 
Окно командных строк обычно расположено над строкой

состояния; оно служит для ввода команд и вывода подсказок
и сообщений AutoCAD. Размеры окна, а следовательно, ко-
личество выводимых строк протокола можно изменять. При
наличии в окне команд более одной строки перемещение по
строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по шири-
не окну AutoCAD (рис. 2.16). Если текстовая строка не по-
мещается в окне, ее полное содержимое выводится в рамке
вблизи командной строки.

Рис. 2.16. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной
полосы, находящейся в его верхней части (если оно закреп-
лено внизу) или в нижней (если оно закреплено вверху). Что-
бы изменить размер, следует захватить разделительную по-
лосу с помощью мыши и отбуксировать ее до требуемой вы-
соты.

Окно может быть как закрепленным, так и плавающим.
Закрепление отменяется путем выбора рамки окна в любом
месте и последующей буксировки за пределы зоны закреп-



 
 
 

ления до тех пор, пока граница окна не примет вид широ-
кой контурной линии. Если отпустить окно в этот момент,
оно станет плавающим и приобретет размер, который имело
до закрепления. Плавающее окно может быть перемещено в
любую позицию экрана; при этом пользователю разрешено
изменять его ширину и высоту (рис. 2.17).

Рис. 2.17. Плавающее окно командных строк

Закрепляется окно команд путем буксировки к верхней
или нижней зоне закрепления окна AutoCAD.

В окне командных строк можно прокручивать текст, вы-
полнять его редактирование и повторно вводить команды.
Для этого используются стандартные клавиши: ↑, ↓, ←, →,
Insert, Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно восполь-
зоваться комбинацией клавиш Ctrl+C, чтобы копировать вы-
деленный текст в буфер обмена, и Ctrl+V, чтобы вставить
содержимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных
строк или текстового окна AutoCAD вызывает контекстное
меню, куда входят шесть последних использованных команд,



 
 
 

функции копирования выделенного текста или всего прото-
кола команд, вставки текста, а также вызова диалогового ок-
на настройки Options.



 
 
 

 
Текстовое окно

 
Просмотреть большую часть протокола команд – так на-

зываемую историю команд (command history) – можно, пе-
реключившись в текстовое окно, показанное на рис. 2.18.
Оно вызывается нажатием функциональной клавиши F2 или
командой TEXTSCR, а также из падающего меню View →
Display → Text Window (F2).



 
 
 

 
Конец ознакомительного

фрагмента.
 

Текст предоставлен ООО «ЛитРес».
Прочитайте эту книгу целиком, купив полную легальную

версию на ЛитРес.
Безопасно оплатить книгу можно банковской картой Visa,

MasterCard, Maestro, со счета мобильного телефона, с пла-
тежного терминала, в салоне МТС или Связной, через
PayPal, WebMoney, Яндекс.Деньги, QIWI Кошелек, бонус-
ными картами или другим удобным Вам способом.

https://www.litres.ru/tatyana-sokolova/autocad-2009-dlya-studenta-samouchitel/
https://www.litres.ru/tatyana-sokolova/autocad-2009-dlya-studenta-samouchitel/

	Введение
	От издательства
	Глава 1
	Требования к системе
	Запуск системы AutoCAD
	Начало работы
	Подробнее о шаблоне
	Вызов справочной системы
	Открытие рисунков
	Создание рисунков
	Определение границ рисунка
	Определение параметров сетки
	Определение шага привязки
	Сохранение рисунков
	Получение твердой копии рисунка
	Выход из AutoCAD

	Глава 2
	Падающие меню
	Панели инструментов
	Стандартная панель инструментов
	Панель стилей
	Панель рабочих пространств
	Панель слоев
	Панель свойств объектов
	Строка состояния
	Окно командных строк
	Текстовое окно

	Конец ознакомительного фрагмента.

